
TWi 
It's About People 

Technical Writing: An 
Introduction 

Job Aids 



TWi 

Contents 
Audience Analysis. ...2 *********. 

Get to Know Your Audience. Z *********************************°****°*'°*****°****°°°****°*******°°*****°°******°**°*°*e*********** 

Find Out What Your Audience Needs ... 3 ****°****°'****"*****"'"**********"******"*******"************************ 

Tailor the Information to What Your Audience Needs... 4 

Information Gathering **************°****°*****°***********"*****°"*****°°"****°********e******************************* 

Build Up Your Subject Matter Knowledge. 5 ***°°*°°°*******°°**°**°°°****°*°°°°°* *****°e***°°**°*°**°******** 

Interview the SME. ******* 

Test the Content... ** ***** o*************e***s*sen**** ****************************** "| 

Elements of Structure.. rurnereser**s*tso*******.*****.*******.***********on**s*** *********************************** 

Make Content Easy to Find. 

Make Content Easy to Understand...*************°******"***°***********************************************o***** 

Make Content Easy to Read. ***********°°***********°*°******************* 10 
***°*****°**°°****°******** 

The Mechanics of Writing.. *****************. ee*****************s********************* ..11 

Correct Common Sentence Issues.. .11 ....******** *** ******* ************°*****°° 

Use Punctuation Correctly. ******* .*** *******************************.*************** ... 13 

Characteristics of Good Writing. .15 
**********°°******"*****°***************e********************°°************°°*******° 

Structure Content Coherently and Cohesively.. ****°°***********°*°******°***********************************o****** .15 

Use Clear and Concise Language.. ..l6 ***********"***********°*"***°°°e****** **°°°*°°°°°°°°°°°°**°*°°°°°° 

Style Guides and Templates.. *°°**°°°*°°°°°°°°°°°°°*°°°°*°°*°°°°°°*°°**°° ° ****°°°*°*°°°°°****°°.****°* 

Use a Style Guide . .****** **********s******.****** 18 °°***°**°°°°°*° **°°°**** 

Use a Template.. ... 19 ************* **e******************** **************** ******o******************** 

Graphics.. ..23 * ***************°* e****°***°*******°**°**°°*°***°******************°**o*********** ee*** 

Choose the Right Graphic Typ... ..23 *************************"*******************************.******eoon*****eoo***. 

Use the Graphic to Best Effect... ******************************************************* ..25 *******.*********** 

Editing ************************************°°************ ******* **************°****°*°**°°****°°"*******"********e** ..26 

Use Editing Tools *******e*******e****************G 26 ** ******************* ***********

Self-Edit.. ..29 
******************°**************°*****°°******************************************************************************* 

Determine a Peer Review Cycle .. *****°**********°*****°**°°° ...32 **********°**************°** 

Give and Receive Editorial Feedback.... .33 **************o******e**** ***°*********e******************°*********** 



TWi 

Audience Analysis 
Use the checklists in this section to complete the following tasks: 

Get to Know Your Audience 

Find Out What Your Audience Needs 

Tailor the Information to What Your Audience Needs 

Get to Know Your Audience 

Categorise your audience in the most appropriateway 
Example: If categorising in terms of expertise, is your audience an expert, a 

technician, an executive, or an end user? 

Consider how much prior knowledge your audience has about the product or 

service. 

Example: Do they need to know what the next step in the process is, or do 

they need to be told how to perform the next step? 

Consider your audience's motivation for using the product or service and for 

reading the content. 

Consider any hurdles that may impact how your audience reads the content. 

Example: Consider whether your audience's work environment impacts how 
they consult the content. 
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Find Out What Your Audience Needs 

To collect quantifiable data, carry out a survey. Include a variety of the following

question types: 

.Open-Ended 

Example: Is there anything you would like to add? 

Closed 

Example: Have you previously used this software? 

Multiple choice 

Example: What is the capital of Ireland? 

a) Cork 

b) Dublin 

c)Galway 
Ranking 
Example: Please rank the following in order of importance from 1 to 3, 
where 1 is the most important: 

Job satisfaction 

Salary 

Job security 
Intensity scale 

Example: Please rate your satisfaction with this training by indicating the 
appropriate scores for each of the following: 

Low High 

12 3 4 5 
The learning objectives were clear. 

The content was structured clearly and logically 

Consider interviewing a subject matter expert about your audience. 

Use social media to monitor the reputation of your company and gain insight 
into the topics that the market influencers are most concerned about. 
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Tailor the Information to What Your Audience Needs 

Summarise the insights you gain from audience analysis in a user profile. 

When building a profile of a typical user, focus on the following types of 

information: 

Job title 

Level of knowledge 

Motivation 

Hurdles 

When creating a persona, include any details that give you a better feel for the 

audience, such as working environment and attitudes. 

If your content is aimed at more than one user type, create a user profile or 

persona for each type. 
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Information Gathering 
Use the checklists in this section to complete the following tasks: 

Build Up Your Subject Matter Knowledge 

Interview the SME 

Test the Content 

Build Up Your Subject Matter Knowledge 

Familiarise yourself with the source information: 

Read high-level informationto understand the main concepts. 

Scan all information to understand the scope. 

Create a hierarchical folder structure to make it easy to locate and track your 

content. 

To identify the relationship between different pieces of information and 
establish any gaps in your knowledge, sketch an information map. 

Use the insights from your audience analysis to focus your independent
research. 

When taking notes, try the two-column approach, prepare headings in advance, 
and use drawings and lines to illustrate and connect ideas. 
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Interview the SME 

Before interviewing anyone, make sure you are clear about the information you 

want to elicit from them. 

To avoid 'yes' or 'no' responses, use open questions. 

Example: How does that work? 

If the goals of the interview include getting the SME to explain something that is 

particularly detailed, consider recording the interview. Ask for permission to 

record the interview in advance. 

To get the most out of any interview, use active listening and reflection, instead 

of focusing on your next question. 

If the SME says something you don't fully understand, check your interpretation:

Try restating what you've understood in your own words. 

Ask questions that elicit more detail. 

Example: Can you elaborate? 

Use your body language and tone of voice to influence the effectiveness of the 
interview. 

At the end of the interview, ensure that both you and the SME are clear on the 
next steps in the development of the content. 

To make the most of any interview, review your notes while they are still fresh in 
your mind. Write a summary of the main points and any action items and share 
them with the SME. 
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Test the Content 

When writing procedures or detailed descriptions of how something works, it is 

important to test the content to ensure it is accurate. 

Make careful note of anything that does not work as described in the content. 

When testing content, use the insights from your audience analysis to think 
about the level of detail that the audience needs. 

Look for opportunities to enhance usability for the audience. 
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Elements of Structure 
Use the checklists in this section to complete the following tasks: 

Make Content Easy to Find 

.Make Content Easy to Understand 

.Make Content Easy to Read 

Make Content Easy to Find 

Break large blocks of information into manageable chunks. Aim for one chunk 

per idea. 

Group related chunks of information.

Eliminate repetition and any unnecessary information. 

When writing headings, use the following guidelines 
Use title case for major words, such as nouns and verbs 
Use sentence case for conjunctions, prepositions, definite, and indefinite 

articles. 

Strike a balance between keeping headings as short as possible and 
indicating the main point of the text. 

Ensure all headings are self-explanatory. 

Use noun-based headings for explanatory information. 

Use verb-based headings for instructions or procedural information. 
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Make Content Easy to Understand 

When presenting information in a list, use the following guidelines: 
Use a bulleted (unordered) list when the order of items is not important. 

Use a numbered (ordered) list when the order of items is significant. 

Include an introductory sentence, followed by a colon. 

Capitalise the first word of each list item, regardless of whether the list 

item is a complete sentence. 

Put a full stop at the end of a list item only if it is a complete sentence. 

Use parallel structure for all items within a list. 

When presenting information in a table, use the following guidelines:

Present data. 
Include an introductory sentence (followed by a full stop), table number 

(followed by a colon), and table caption (in sentence case). 

Use parallel structure for text in table columns. 

When presenting information in a diagram, use the following guidelines:

Include an introductory sentence (followed by a full stop), figure number 
(followed by a colon), and figure caption (in sentence case). 

Ensure that the diagram you use emphasises the information that you 
want to highlight. 

Use 2-D charts instead of 3-D charts because 3-D charts can easily 
distort data. 

Use colour sparingly because it is expensive to print and too many 
colours can be overwhelming.
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Make Content Easy to Read 

Establish a clear hierarchy of fonts and use them consistently throughout your 
content. 

Use a sans serif font for on-screen text. 

Use bold to emphasise key words, a note, or a caution. 

Use italics to indicate a quote or an expression in another language. 

Use emphasis sparingly and consistently to maintain impact and avoid 

confusing the audience. 
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The Mechanics of Writing 
Use the checklists in this section to complete the following tasks: 

Correct Common Sentence Issues 

Use Punctuation Correctly 

Correct Common Sentence Issues 

Correct run-on sentences. 

A run-on sentence consists of two or more independent clauses connected 
without an appropriate punctuation mark or conjunction. 

Example: It is nearly five o'clock, we will not reach home before dark. 

Revised: It is nearly five o'clock. We will not reach home before dark. 

Correct sentence fragments. A sentence fragment is not a complete sentence 
because it lacks either a subject or verb, or does not express a complete 

thought. 
Example: If there is insufficient memory. Displays a warning message. 

Revised: If there is insufficient memory, the system displays a warning 
message. 

Correct subject-verb disagreement. 

Subject-verb disagreement occurs when a singular subject is used with a plural 
verb, and vice versa. 

Example: She walk to the park. 

Revised: She walks to the park. 

Collective nouns are treated as a singular subject. 

Example: The team is here. 

Be consistent in your use of tense. Unnecessary shifts in tense can be 
confusing for the audience. 
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Quick Reference: Sentences 

A sentence requires a subject, a finite verb, and appropriate punctuation. 

Adjective 
A word that describes a noun or pronoun. 

Example: A tall building. 

Adverb 

A word that describes a verb or adjective. 

Example: The train moved quickly. 

Clause 
A group of related words that contain a subject and a verb. A sentence can contain a single 

clause or multiple clauses. 

An independent clause contains a subject and a finite verb and expresses a complete 

thought. 
Example: If you stay here, r'l be back. 

A dependent clause contains a subject and a verb, but does not express a complete thought. 

Example: If you stay here, l'll be back. 

Conjunction 
A word that links two parts of a sentence or two words. 

Example: Mary and Jo went to the shop, but they forgot their money. 

Noun 

A word that denotes a person, place, or thing. 

Example: The restaurant is open. 

Object 
The object in a sentence is the person or thing acted upon by the subject. 

Example: The company hired two new employees 

Pronoun 

A word that replaces a noun or noun phrase. 

Example: The children donated their books to a charity. 

Subject 
The subject is the who or what carrying out the action. It specifies the topic of the sentence. 

Example: Not all who wander are lost. 

Verb 

A word that expresses an action or a state of being. 

12 
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Use Punctuation Correctly 

When using commas to divide up a sentence, use the following guidelines: 

Use a comma to indicate a pause, to group and separate items, and to 
divide the structural elements of sentences into meaningful parts. 

Determine how to use the comma in a series of items and be consistent. 

The serial comma is the comma before the coordinating conjunction in a 
series of three or more items. Use of the serial comma is optional. 

6dyet 

Use commas around clauses that add non-essential information to a 

sentence(non-restrictive clauses). t whiCch 

Example: The company's new style guide, which ill be in use by 
December 1, ensures consistency in all documents. 

Do not use commas around information that is essential to the meaning9 
of the sentence (restrictive clauses). that 

Example: The style guide that the company is using is outdated. 

Use the apostrophe of possession correctly. 

For singular nouns, form the possessive by adding an apostrophe and an 
's'. If a singular noun already ends in 's, either add an apostrophe andan 
's' or just an apostrophe. Both are correct. 

Example: They produced a digital edition of Keats's poetry. 

Revised: They produced a digital edition of Keats' poetry. 

For plural nouns that ernd in 's', form the possessive by adding an 
apostrophe after the 's. 

Example: The shareholders' expectations were frustrated. 

For plural nouns that do not end in 's, form the possessive by adding an 
apostrophe and an 's. 

Example: The product is sold in the men's department.

Never add an apostrophe to possessive pronouns, such as his, hers, 
ours, your, their, and its. 

Example: The company outlined its mission statement. 

Never use an apostrophe to make a noun plural. 

Example: The two chairs cost 300 euros. 

Use the apostrophe of omission to indicate that letters in a word have been 
omitted. 

Example: They're {they arel going to their [possessive pronoun] car, which is 
over there lindicates placej. 
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Quick Reference: Punctuation
To be complete, a sentence must be punctuated correctly. An explanation of how to use 

apostrophes and commas correctly is provided in the Use Punctuation Correctly checklist. 

Colon 

Use a colon to introduce explanatory statements. 

Example: The manager didn't make a good start: he outlined the disciplinary action 

without explaining what had happened. 

Use a colon to introduce a list where the introductory statement is an independent 

clause. 

Example: The department purchased the following new stationery for its offices: 

folders, envelopes, and notepads. 

Full Stop 

Use a full stop at the end of a complete sentence. 

If the last word in a sentence is an abbreviation that ends with a full stop, do not add 

a second full stop at the end of the sentence. 

Example: The system administrator has scheduled the batch run for 7 p.m. 

Use a full stop in some abbreviations. 

Example: The staff will start on Monday, Dec. 1 in the new campus. 

Hyphen 
Use a hyphen when forming a single adjective made up of more than one word 

(compound adjective). 
Example: He provided an up-to-date set of figures. 

Do not use a hyphen when the compound adjective comes after a noun. 

Example: The department's figures are up to date. 

Semi-Colon 

.Use a semi-colon to join two independent clauses in a sentence when the clauses are 
too closely related for a full stop. 

Example: Don't capitalise the first word after a semi-colon; always use lowercase. 

.Use a semi-colon to separate items in a list when the items are long or complex, or 
the list items already contain internal commas. 

Example: The milestones for the project are January 31, 2015; October 30, 2015; 
and January 31, 2016. 

Avoid using semi-colons in technical writing because they can result in lengthy, 
complicated sentences. 
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Characteristics of Good Writing 
Use the checklists and procedures in this section to complete the following tasks: 

Structure Content Coherently and Cohesively 

Use Clear and Concise Language 

Structure Content Coherently and Cohesively 

Consider how you can guide your audience by structuring your content logically 
and clearly beneath headings. 

Use transitional phrases to create cohesive content. When using transitional 
phrases, use the following guidelines: 

To support the initial point, use 'and, also', or 'in addition 
To illustrate or expand a point, use for example', similarly', or likewise'. 

To summarise or show the effect, use therefore', 'so', 'consequently', or 
'in short. 

To qualify a point, use frequently', in particular, or "in general'. 

To reverse or deflect an idea, use 'but, 'however, or yet. 

.To concede a point, use 'although' or 'whereas'. 

To connecta reason to an assertion, use 'because', 'since, or for' 
To improve understanding and cohesion in your content, start with familiar 

information and then move to new information. 

To clarify how sentences are connected and how ideas develop, repeat a word 
from one sentence in the following sentence. 

Example: The interface consists of five menus. Each menu provides access 
to different sections of the customer record. Access to each customer 
record is determined by the login role. 

15 
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Use Clear and Concise Language 

Break longer sentences into shorter sentences. Limit each sentence to one idea. 

Make your content clear by translating jargon into plain language. 

Choose short, familiar, and concrete words over long, unfamiliar, and general 

words. 

Remove bloated language and redundancy. 

Use the active voice. To change content written in the passive voice into the 
active voice, search for sentences that contain any form of the verb to be 

(was, 'am, 'are', 'been', and is) and rewrite them so that the subject performs 

the action. 

Example: Complex material is organised into content that is easy to 

understand by technical writers. 

Revised: Technical writers organise complex material into content that is 

easy to understand. 

When writing instructive text, start each sentence with the imperative form of 

the verb. 

Example: Organise complex material into content that is easy to understand.

Eliminate noun phrases derived from verbs (nominalisation). 

Search for words ending in ion', "ment', 'ness', tion', and '-ence' and change 
them back into verbs. 

Example: The organisation of complex material into content that is easy to 

understand is the aim of the technical writer. 

Revised: Technical writers organise complex material into content that is 

easy to understand. 

At the first instance of an abbreviation or acronym, state the full term and 

introduce the abbreviation or acronym in parentheses. 

Use the abbreviation or acronym in subsequent instances. 

Decide on a phrase to convey a basic action and then reuse it throughout your 

content. Using standard phrasing improves consistency. 

Example: This chapter describes.. 

Break up phrases that contain strings of nouns by replacing them with 

prepositions. 

Example: The report refers to two-channel linear pulse code modulation data. 

Revised: The report refers to modulation data about thelinear pulse codes 

with two channels. 

16 
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Procedure: To Enable the Readability Feature in Microsoft Word 

All procedures in this booklet are based on using Microsoft Word 2016. 

1. From the File menu, choose Options. 

2. In the Word Options dialog box, choose Proofing. 

3. In the When correcting spelling and grammar in Word area, select Check grammar 

with spelling and Show readability statistics. 

4. Choose OK. 

Procedure: To View the Readability Score 

1. Open your document in Microsoft Word. 

2. On the Review tab, choose Spelling & Grammar. 

Once the spelling and grammar has been checked, the readability score displays. 

17 
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Style Guides and Templates 
Use the checklists and procedures in this section to complete the following tasks: 

Use a Style Guide 

Use a Template 

Use a Style Guide 

if your company does not have a style guide in place, select one to use. 
Consider the options carefully, and pick a style guide that is suitable for the 
needs of your company. 

Example: Think about whether your content should be written in UK or US 
English. The University of Oxford Style Guide uses UK English, while The 
Chicago Manual of Style uses US English. 

Consider using one of these approved style and formatting guides: 

The Chicago Manual of Style, 16th edition, University of Chicago Press, 
2010 

The Oxford Guide to Style, 8th edition, Oxford University Press, 2002 

Microsoft Manual of Style. 4th edition, Microsoft Press, 2012 

18 
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Use a Template 

If your company does not use templates, consider creating a template that 
reflects your style guidelines. 

When creating a template, use the following guidelines: 

Create a new template from a blank document. If you customise an 

existing template, it is likely that unwanted formatting could be caried 
over into your new template. 

Build style specifications into your template formatting styles. 

Include instructional prompts in your template to guide the writer to 

create appropriate content at the right level of detail. 

Once a template is reviewed and approved, provide training to the writers who 
will use the template. 
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Procedure: To Modify a Style Using the Update to Match Selection Option 

1. Identify some text that uses the style. 

2. Format the text as required. 

3. In the Styles panel or list, right-click the style and select Update [style name] to 
Match Selection. 

Procedure: To Import Styles from Other Templates 

1. Display the Styles window (on your keyboard, use the key combination 

Alt+Ctrl+Shift+S). 
2 Choose the Manage Styles button. 

3. In the Manage Style dialog box, choose Import/Export.. 
4. In the Styles available in drop-down list on the lefthand side, browse to the current 

template. 
5. In the Styles available in drop-down list on the right-hand side, browse to the other 

template. 
6. Select the styles to be copied and choose Copy. 

Note: Styles can be copied to and from each template. 

Procedure: To Apply the 'Keep with next' Attribute to a Table Caption 

1. In the Styles panel or list, right click the style and choose Modify. 
2. In the Modify Styles dialog box, choose Format. 

3. From the Format menu, choose Paragraph. 
4. On the Line and Page Breaks tab, choose Keep with next and choose OK. 

Procedure: To Display Styles That Are in Use 

1. Display the Styles window (on your keyboard, use the key combination 

Alt+Ctrl+Shift+S). 
2 Choose Options... 

3. From the Select styles to show drop-down list, select In use. 

Procedure: To Ensure the Created Styles Are Not Set to Automatically Update 
1. In the Styles panel or list, right-click the style and choose Modify. 
2. At the bottom of the Modify Styles dialog box, deselect Automatically update. 
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Procedure: To Add a Table as a Quick Table for Easy Reuse 

1. Select the table you wish to use as a Quick Table. 

2. In the toolbar, choose Insert>Table->Quick Tables > Save Selection to Quick Tables 

Gallery.. 
3. In the Name field, enter the name of the table. 

4. In the Save in field, select the current template filename, and choose OK. 

5. Save your template. 
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Graphics 
Use the checklists and procedures in this section to complete the following tasks: 

Choose the Right Graphic Type 
Use the Graphic to Best Effect 

Choose the Right Graphic Type 

Flow diagrams are an effective way of illustrating a process. Depending on the 

process, it can be either linear or circular. 

Example: 
Analyais 

Evaluate Desig 

) Implement 

Radiating diagrams illustrate the point when various elements merge or split. To 

illustrate a two-level hierarchy, add a core element. 

Example: 
Diagrams 

Graphics 

Photographs Screen shots 

Structure diagrams illustrate the hierarchy of different elements, or how they 
build on each other. 

Example: LVarisbie 

Categorcal Numerical 

Diccrete o O 

Trend diagrams illustrate how data fluctuates over a period of time. 

Example: 
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Screenshots are an effective way to explain complex interfaces and behaviour 
that is difficult to describe in words. When using screenshots, it's important to 

consider how quickly they will become outdated. 

if using photographs, ensure you compiy with copyright law. Gradually build up 
a library of images to reuse. Consider overlaying elements of your brandings to 
create a cohesive family of images. 

Ilustrations allow us to highlight or omit details to help the audience understand 
how something works. 

Example: 
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Use the Graphic to Best Effect 

Create a dedicated graphics folder with sub-folders for different types of 

graphics 

Keep source files separate from edited files. 

Use intuitive, descriptive names that specify the content of the graphic. 

If more than one computer or monitor is used to capture screenshots, ensure 
the display settings and screen resolution on any computers used to capture 
screenshots are the same. 

In procedural lists, insert the graphic directly after the relevant step. 

In body text, insert the graphic directly after an introductory sentence. If you 
need to provide any additional information, put it below the graphic. 

To draw the audience's attention to a particular part of a graphic, layer a 
rectangular box over the graphic. 

To identify several elements within the graphic, consider using numbers in 
circles layered over the graphic and a table legend below the graphic. 
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